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Introduction 
 
This manual will detail most of the menu options found in the Word 2003 menu File.  
The File menu options discussed in this manual are: 

◘ New 
◘ Save As 
◘ Search 
◘ Versions 
◘ Page Setup 
◘ Send To 
◘ Properties 

 
Each menu item will be defined and will provide reasons to use that particular menu 
option.  Following the background information, there will be a Step-by-Step that will 
provide instruction on how to use the tools and commands.  Some processes that you 
perform from the menu, can also be done other ways.  If there is an Alternative method, 
this would be the last part of each lesson. 
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New 
 
Definitions 
 
Word Definition 
Template (Per Microsoft Help)  A file that contains the structure and tools for 

shaping such elements as the style and page layout of the finished 
files. 
 

 
Why would you use this? 

◘ To open a new blank document. 
◘ To open an existing file with a “Document X” name so you can start from a 

new document without overwriting the existing file. 
◘ To open a template. 
◘  

 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
File, New 

The New Document task pane displays. 

 
 

2. To open a blank document, click 
on the Blank document link. 
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What you do What happens 

3. To open an existing file and use 
this file as a starting point for a 
new file, click on the From 
existing document link. 
 

This gives you the file you asked for, but with a 
“Document” name like a template. 

4. To open a Microsoft Word 
template or a template that you 
created click on the On my 
computer link under the 
Templates heading. 
 

The Templates box displays. 

 
 

5. To go directly to Microsoft’s 
Template web site, click on the 
Templates on Office Online link. 
 
Some ideas of what templates are 
available: 

 Brochures 
 Business Cards 
 Calendars 
 Certificates 
 Newsletters 
 Post Cards 
 Letters- Letter Heads 

 

The Office Online Templates page displays. 
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Alternative Methods 
What you do What happens 

1. You can use the New Blank 
Document icon .   
 
Note:  If you use this method, you 
do not get the New Document task 
pane.  You are just returned a new 
blank document.  
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Save As 
 
Definitions 
 
Word Definition 
Save As Save As allows you to save a file with a new name, extension, or 

location. 
 

 
Why would you use this? 

◘ To save a new document. 
◘ To change the file extension of a document. 
◘ To change the location of the file. 
◘ To create a template from a Word document. 
◘  

 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
File, Save As 

The Save As box displays. 

 
 

2. To change the location of the file, 
use the down arrow in the Save in 
field to find the new location. 
 
In the File name field, enter a 
name for the file. 
 
Leave the Save as type field as 
Word Document (.doc) unless you 
are creating a template.  To create 
a template, use the drop down and 
select Document Template (.dot). 
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What you do What happens 

3. To use a template, you would use 
the New Document task pane.   

The New Document task pane. 

 
 

4. Click on the link for On my 
computer… under the Templates 
section. 
 
A template you created can be 
found on the General tab. 

The Templates box displays. 

 
 

5. Select the template and click on the 
OK button. 
 

 

 
Alternative Methods 

What you do What happens 

1. You can also use the Save  
button on the Standard toolbar. 
 

Note:  You only get the Save As box if that is the first 
time you save the file.  
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Search 
 
Why would you use this? 

◘ To search for a document. 
◘  

 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
File, Search 
 
Basic searching returns files 
containing these words, whether 
they are in the body of the file, in 
keywords or in other file 
properties. 

The Basic Search task pane displays. 

 
 

2. In the Search text field, enter part 
of the file name.   
 
Click on the Search button. 
 

A list of files that met the criteria will be listed in the 
Search Results task pane. 

3. If you put the mouse over the file, 
an arrow will appear on the right 
side.  Click on the arrow for a list 
of choices.   
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Versions 
 
Definitions 
 
Word Definition 
Versions (Per Microsoft Help) If you want a record of changes made to a 

document, you can save multiple versions of a document within the 
same document.   
 
You can then view these versions and select the one you would like 
to use.  You can imagine each version as a snapshot or picture in 
time. 
 

 
Why would you use this? 

◘ To record changes to a document over time and conserve disk space. 
◘ To review what information an older version contained. 
◘ To save an older version as a separate file so that you can compare documents. 
◘  

 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
File, Versions 
 

The Versions box displays. 
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What you do What happens 

2. Click on the Save Now button. The Save Version box displays. 

 
 

3. Enter a description for this version 
of the document and click on the 
OK button. 
 

 

4. The document returns.  In the 
Status bar, you should see the 
Version icon .   
 

 

5. Each time you want to save a 
version of the document, you can 
either choose from the menu File, 
Versions or you can double click 
on the Versions icon  in the 
Status bar.  Click on the Save Now 
button and enter a description. 
 
Note:  If you want to automatically 
save a version when you close a 
file, select the Automatically save 
a version on close checkbox. 

The Version box displays again. 
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What you do What happens 

6. To open a version you can either 
choose from the menu File, 
Versions or you can double click 
on the Versions icon  in the 
Status bar. 

The Versions box displays.  

 
 

7. Select the version you want to open and click on the Open button. 
 
Once you select an older version, the Word window automatically splits the screen, on the 
bottom is the version you selected to open, with the original document on the top half of the 
window. 

 
 

If you want to view the version document, you can maximize that window by using the sizing 
buttons for that document window.  This will allow you to view this version of the document in 
the full window.  When you are done reviewing the version or after you have Saved As you can 
close the version. The version still exists, unless you select it in the Versions box and push the 
Delete pushbutton. 
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What you do What happens 

8. Note:  You cannot modify earlier 
versions unless you open that 
version and use File, Save As and 
create a new and separate file. 
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Page Setup 
 
Definitions 
 
Word Definition 
Margin The distance between text and the edge of the paper on the top, 

bottom, left, and right. 
 

Gutter The amount of space added to the margin for binding purposes. 
 

 
Why would you use this? 

◘ To change the margins. 
◘ To change the orientation of the page (Portrait or Landscape). 
◘ To change the headers and footers for odd and even pages. 
◘ To change the header and footer for just the first page, such as a title page. 
◘  

 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
File, Page Setup 
 

The Page Setup box displays. 
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What you do What happens 

2. On the Margins tab you can adjust 
the Margins or Gutter 
measurements. 
 
You can also adjust the 
Orientation to Portrait or 
Landscape. 
 
In the Pages area, you can set the 
pages to mirror each other, print 
two pages on a sheet, of as a book 
fold. 
 
You can also choose to apply the 
changes to the Whole document or 
This point forward by using the 
Apply to field.  
 

 

3. Advance to the Layout tab. The Layout tab displays. 
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What you do What happens 

4. To create different headers and footers for odd and even pages, click on the checkbox for 
Different odd and even. 

 
 

5. To have a different (or no) header 
or footer on the first page of your 
document, click on the checkbox 
for Different first page.  This is 
typically used for title pages.   
 

 

6. Under the Page section, you can 
set the Vertical Alignment of the 
document.   
 
This allows you to specify the text 
vertically between the top and 
bottom margins of a page. 
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Alternative Methods 
What you do What happens 

1. You can adjust the margins by 
using the horizontal and vertical 
rulers in the Print Layout view.   
 
If you place the cursor between the 
gray and white areas at the 
beginning and end of the rulers the 
cursor will change to a double 
pointing arrow.  With the left 
mouse button pressed down, you 
can drag and drop any of the 
margins.   
 

The Rulers: 
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Send To 
 
Definitions 
 
Word Definition 
PDF Portable Document Format.  A file format that represents a 

document in a manner that is independent from the original 
application used to create the original document. 
 

 
Why would you use this? 

◘ To send the file to a person via Outlook Mail as an attachment  
◘ To send the document as the e-mail itself. 
◘  

 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
File, Mail Recipient. 
 
This will allow you to use the text 
in the document as the body of 
your e-mail message.   

The Word window adjust to allow for the e-mail message: 

 
2. Enter information into the To field, 

adjust the Subject (default subject 
is the name of the file) and click on 
the Send a Copy button. 
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What you do What happens 

3. From the menu choose: 
File, Mail Recipient (for review) 
 
This will allow you to send the file 
as an attachment and the subject 
will be, “Please review” and then 
the file name.  
 

An Outlook  window appears for the e-mail message: 

 
4. Enter information into the To field, 

and click on the Send button. 
 

 

5. From the menu choose: 
File, Mail Recipient as Adobe 
PDF 
 
This will allow you to send the file 
as an attachment in PDF format.  If 
you choose this method, you will 
be prompted to save the file as an 
Adobe file, click on Yes.   
 
Note:  You must have the full 
version of Abode in order to have 
this option available to you. 
 

An Outlook window appears for the e-mail message: 

 

6. Enter information into the To field, 
and the Subject  and click on the 
Send button. 
 

 

7. From the menu choose: 
File, Mail Recipient as 
Attachment 
 
This will allow you to send the file 
as an attachment and the subject 
will be the file name. 
 

An Outlook window appears for the e-mail message: 
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What you do What happens 

8. Enter information into the To field, 
adjust the Subject (default subject 
is the name of the file) and click on 
the Send button. 
 

 

 
Alternative Methods 

What you do What happens 

1. The alternative method would be 
to use Outlook to draft your e-mail 
message and to manually attach the 
file as a Word document or PDF 
file.  
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Properties 
 
Why would you use this? 

◘ Allow you to add details to a file such as a title, author name, subject, and 
keywords. 

◘  
 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
File, Properties 
 

The Properties box displays. 
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What you do What happens 

2. On the General tab there is general 
information such as the date you 
created the file, the last time you 
modified the file, and the last time 
you accessed the file.   
 
Click on the Summary tab. 

The Summary tab displays. 

 
 

3. On the Summary tab you can enter 
a Title, Subject, Author, Manager, 
Company, Category, Keywords, or 
Comments. 
 
Click on the Statistics tab. 
 

The Statistics tab displays. 
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What you do What happens 

4. On the Statistics tab you can find a 
lot of valuable information about 
the file such as the number of 
pages, paragraphs, lines, words, 
and characters.   
 
Click on the OK button to remove 
the Properties box. 
 

 

 


